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ABSTRACT: 

 

Such innovative meeting dedicated to Cultural Heritage: challenges, new perspectives, and technological innovation are ‘vital’ in 

order to exchange different experiences, needs, opportunities, and, above all, to find new approaches to preserve, at least, the 

memory of heritage for further generations. This paper includes some experiences accumulated throughout several topographic 

projects concerning Christianity during the Late Antiquity and Early Medieval Ages in northern Syria, in Liguria in Italy, and in 

Provence in France. Geospatial and Geomatics data have been used in these investigations, since 2007, thanks to the Pontifical 

Institute of Christian Archaeology of Rome, the National Institute for Art History in Paris, Nino Lamboglia Foundation, and Marc de 

Montalembert Foundation. The Geospatial data highlighted for the first time, after about a century of research, much un- published 

data about Syrian monasteries. One of our goals was to understand what the exact differences are from all points of view: time, 

results, and economic costs between Agisoft Photoscan and MicMac. The models of the two applications are well made, but we 

noticed that the model created by MicMac software is excellent, despite being an open source application. In 2017, due to the 

positive geomathic results during the last three seasons of our excavations on the site of Capo Don, the first Multimedial Exhibition 

Space (SEM) of the town Riva Ligure was inaugurated, thanks to Comune of Riva Ligure, and all research team members guided by 

professor Philippe Pergola. Geomatics is a powerful tool not only for preserving memories, but it is ideal for dissemination heritage 

on the public levels, exactly like the role of archaeology. 

 

 

1. TOPOGRAPHICAL FRAMEWORK 

Usually, it is very risky for the integrity and the transitional 

fluidity of the text to present the archaeological results of three 

geographically distinct territories, like the Syrian Limestone 

area, the Liguria region in Italy, and Provence in South-Eastern 

France. Although, they are very distant from a geographical 

point of view, however, between the second half of 4th and the 

end of the 6th century, they are distinguished by the same 

architectural and topographic development processes. 

Chronologically, these progressions have occurred, almost, 

simultaneously with some slight differences, due to 

geographical and/or political reasons.  

According to the epigraphic sources, the Christianization of the 

rural Syrian Limestone region was started in the late 4th and 

early 5th century. Between the 5th and 6th centuries, the rural 

inhabited areas of the classical period of the region experienced 

a long period of transformation and expansion. In the 5th 

century, temples were transformed into Christian worship 

spaces. From the later part of the 4th century, hundreds of 

basilicas, chapels, and monasteries were built (1). Among the 

second half of the 5th and the first half of 6th century, the 

quantity of churches erected was increased radically. The 

basilicas with three naves could have enormous dimensions: 

some may have had 30 m in length, which evokes the churches 

built in city centres of Syria. The settlements, also, knew an 

impressive demographic growth, that it led to an intensification 

with the construction of the residential facilities (2).  

Although the monastic phenomenon in Syria existed since the 

3th century, throughout the Late Antiquity it experienced a big 

prosperous period. Monasteries, hermitages and many stylite 

pillars were raised. Some of them were installed next to the 

                                                                 
(1) Butler, 1929. Tchalenko, 1979. Tchalenko, 1990.  
(2) Tate, 1992, 305-314. 

roman roads; others were located close to the secular 

settlements. It seems that monasticism has played an important 

economic, social and spiritual role in the region. Some 

monasteries were becoming pilgrimage centres due to the 

presence of holy monks or holy objects of public worship. Other 

monasteries were specialized in the production of olive oil 

because the present oil mill. The monasteries brought a lot of 

wealth into the region that can be interpreted today from the 

high architectural level of the structures of the monasteries (3).  

In Occident, the Christian monuments, during in the Late 

Antiquity, have reshaped the Roman rural landscape. The 

archaeology of rural landscape in Liguria and Provence restored 

a very similar image to the Syrian territorial reality. We have 

fragmentary archaeological data deriving from singular 

researches and emergency and didactic excavations conducted 

by various university teams, such as the Pontifical Institute of 

Christian Archaeology, the University of Genova, and the 

University of Aix Marseille.  

The recent archaeological acquisitions in the field allow us to 

delineate with a certain precision the geography of the oldest 

rural ecclesiastical settlements in Liguria. Since the beginning 

of 2000, archaeology has highlighted important examples of 

Christian settlements of different types. There are the ruins of 

the baptismal-funeral basilica of Capo Don, Costa Balenae, near 

Riva Ligure (6th century)4, the Pieve del Finale (5th - 7th 

century)(5), San Paragorio in Noli (V-VI), Santa Maria of 

Vezzano (5th - 6th century)(6), and San Venerio in Antonina, near 

Migliariana, in the territory of La Spezia (7). 

                                                                 
(3) E. K. Hanna, 2018, 7-80. 
(4) Pergola et al., 381-412. 
(5) Frondoni, 2003, 156-158. 
(6) Frondoni, 2000, 153-184. Frondoni, 2003, 140-142. 
(7) Frondoni, 2003,  137-138. 
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In Liguria the insular monastic settlements are displayed on 

many islands: there are two oratories dating back to the 5th 

century on the Bergeggi (8) and Tinetto(9) islands. Also on the 

Tinetto Island another worship building with two naves and 

three apses with cells in front of the building dated back from 

the 10th to the 11th century. Contemporary with the previous 

structures, there is another monastery located on the island of 

Tino, next to Tinetto, which consists of two pre-existent 

settlements, the oldest of which could be dated back to the 5th - 

6th century(10). Since ancient times, the geographic formation of 

the area of Liguria, which is a totally mountainous territory, has 

always made moving around the area particularly problematic 

outside the roman main roads. In this context, it is not surprising 

to note that all archaeological vestiges of the Late Antiquity and 

Early Middle Age are located precisely next to the ports and 

official main routes. This does not mean that the mountains 

were not inhabited, but rather, some recent archaeological data 

has started to draw a new panorama of the rural Ligurian 

territory. For example, investigations after the year 2010 have 

confirmed that the fortified site of Campo Marzio has revealed 

stratigraphic layers dating back to the 7th century. The site is a 

Byzantine fortification, located next to the Argentina river, on 

the byzantine borders with the Lombard kingdom (11). 

The nearby Provence region is one of the richest regions in 

Early Christian and Early Middle Ages of archaeological sites 

in southern Gaul. The influence of urban architectural models is 

particularly clear in rural ecclesiastical constructions on a 

stereotypical level. Many churches have been identified within 

the countryside of the region, dated between the 9th and 12th 

centuries, as well as the churches of Saint-Maximin and Saint-

Hermentaire next to Dragignan, and Notre-Dame-du-Brusc in 

Châteauneuf-de-Grasse. They are also characterized by 

frequentative phases of the 6th century (12). All these structures 

have the same plan: a very large single nave, to which is 

attached a small baptistery located to the west. In this period, a 

main part of the classic villas already was abandoned in favour 

of the inhabited centres, positioned on the hills and between the 

mountains of the Maritime Alps. In this period, the phenomenon 

of perched villages was identified in the region, exactly between 

the late 5th century and early 6th century, as the site of Sainte-

Candie(13). 

From the end of the 4th century, the presence of sarcophaguses 

with Christian decoration in the sites of Saint-Maximin, Celle, 

and Sannes, testifies to the burial of a Christian elite in these 

rural domains. Funeral structures claim that during the 5th 

century and even more in the beginning of the 6th century, the 

Christianization movements were intensified. 

The monastic movements in Provence, according to the literary 

sources, rises with Saint Martin of Tours, toward the 4th century, 

with the foundation of the two monasteries: Ligugé and 

Marmoutier. Those monasteries, soon, would become a 

lighthouse for all the monasticism in region because they 

donated many bishops to the cities southern Gaul. During the 

early part of the 5th century, Saint Honorat, after a brief 

monastic experience in the East, had retired with his family into 

the islands of the archipelago of Lérins. The smallest island 

includes, even today, the abbey of Lérins, a fortified monastery 

and seven scattered chapels. These chapels have a large 

chronological arc: from the 9th to the 14th century.  

                                                                 
(8) Bulgarelli  2003, 211-219. Frondoni, 1998, scheda 15. 
(9) Frondoni, 1987, 265-274. Frondoni, 2003, 136-137. 
(10) Frondoni, 2003, 134-136. 
(11) Lamboglia, 1950, 48-49. Gamabro 2008, 108-110. 
(12) Codou, 2013, pp. 126-130. 
(13) Segura, 2015-2016, 25-32. 

Under the chapel dedicated to St. Savior, remains of a pre-

existent mono-apse religious building and various adjacent 

rectangular cells, have been found. They were interpreted by 

Yann Codou as a hermitage of 5th - 6th century with different 

occupation levels until the 12th century (14). If this interpretation 

is correct, this building would be the only insular monastery, 

until today, found in this part of the Mediterranean Sea. The 

ascetic ideal, so widely developed during the 5th century by the 

Provençal foundations, spread among the population, especially 

thanks to the monks called to the episcopate that they spread the 

model in their diocese. 

In the following papers, only some of our results will be 

summarized, achieved during the investigations of the team in 

the Mediterranean transboundary area: Syria, Italy, and France, 

related to geomatics and spatial analysis. All this research was 

scientifically directed by Philippe Pergola, research director in 

the French CNRS and professor at the Pontifical Institute of 

Christian Archeology in Rome. Some of these investigations are 

individual initiatives, others are planned research conducted 

through team work of doctoral and post-doctoral students. The 

funds used may have private origins as the archdiocese of the 

Syriac Orthodox Church of Aleppo, diocese of Ventimiglia, as 

well as Nino Lamboglia Foundation, direct by Alessandro 

Garrisi, field director of the excavations at archaeological site of 

basilica of Capo Don in Riva Liguria, and Marc de 

Montalembert foundation. Also some public funds obtained 

from the communes has been used. 

 

2. MICMAC: MODALITIES, EXPERIENCES, AND 

RESULTS 

The so-called MicMac software is developed by the French 

Institut National de l'Information Géographique et Forestière. It 

is, for the moment, the only multiplatform (Windows, Mac OS, 

Linux), and completely free solution for photogrammetry from 

tie points matching to meshing and texturing. Released under 

the license CeCILL-C, it is a free software as stated by the Free 

Software Foundation. It offers two ways to work: the first one, 

and the more preferable one, is the terminal, which is well 

designed and easily supports scripts in many languages to 

serialize operations; the other way is a GUI called CEREMA, 

which is not updated frequently with the last version dating 

back two years.  

Of course when a graphic interaction is needed, e.g. when GCPs 

must be specified on photos or a mask drawn, it is available as a 

graphic solution to interact with the program. Community 

driven support is reachable on the dedicated forum 

(http://forum-micmac.forumprod.com/), or on the Reddit page 

(https://www.reddit.com/r/MicMac). On the GitHub website it 

is possible to download the source code, binaries (Windows and 

Mac), and a very good documented manual. Even though most 

parts of the documentation are in English, sometimes French 

may help to understand some other parts, which are not 

translated into English. 
MicMac application has been part of an experiment in the 

Basilica of Capo Don ‘Costa Balenae’, since 2017. The project 

was carried out by the Pontifical Institute for Christian 

Archaeology and the Nino Lamboglia Foundation. In the 

occasion of the opening of one of the coffins, situated in the 

northern nave of the church, the team opted to use MicMac as a 

preliminary experiment. After a long elaboration with less than 

60 photos, the dense cloud that resulted was composed of over 

17.000.000 points, even though SIFT is not the best algorithm 

to elaborate very dense cloud points. After the internal 

orientation (Tapioca and Tapas), sparse and dense point cloud 

                                                                 
(14) Codou, 2012, 77-81. 
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(AperiCloud, and C3DC) were elaborated with the automatic 

processing. The final result (figure 1) was then processed in 

Meshlab with filter Poisson and transferring of the color 

attribute to the texture. The model was finally 3D printed by the 

CoDArchLab in Cologne. 

 
Figure 1. The printable coffin, the site of Capo Don ‘Costa 

Balenae’. 

The encouraging products drove the team to go further with the 

experiment. During the excavation of 2018, the team tried to 

survey every identified stratigraphic unit. The total number of 

surveys was about 20 with a total of 869 pictures, and with a 

resolution of 5184×3456px.  All photos were taken with a 

Canon APS-C 600D photo camera hooked to a 3,3 m telescopic 

brace in carbon and equipped with a Sigma 10-20mm (focal 

length 10mm). 

It was not possible to survey every SU with MicMac, because of 

some problems due to the differences between the old and new 

gotten GCPs. These points sometimes gave us unpredictable 

results as translations and incorrect absolute position or 

orientation in some orthophoto mosaics. These problems were 

difficult to manage and they are still under investigation: the 

first hypothesis is a lack of GPS precision. Better results in this 

hard situation have been achieved with Pix4D15, which was 

used in parallel to control and see differences in the results 

(figure 2). Even in those cases, it is our opinion that it is still 

problematic to have a correct stratigraphical sequence in 

subcentimetric precision without a denser and more flexible 

mapping with a Total Station.  

 
Figure  2. Example orthophoto mosaic for a single a 

Stratigraphic unite. 

Furthermore, we are still looking for some new techniques to 

acquire precisely the Z factor, which is very important for 

archaeological investigations. Another tricky situation comes 

from the fact that some portions of the photos are less visible 

than the others, which is due to the contrast differences between 

                                                                 
15 To know more about Pix4D, see its price, and its features: 

https://www.pix4d.com/product/pix4dmodel 

the illuminated and shaded areas. At the moment we are looking 

to bypass this problem with some batch post-processing 

methods, resetting all the contrast and brightness values of the 

pictures. The weather was good along all the campaign, so we 

did not have to face problems with camera movements.  

It is obligatory to present two more cases to get a full idea of the 

team’s experiences and applications of the MicMac software. 

The other case of study was carried out within the project: les 

monastères des îles mineures de Provence et des archipels ligure 

et toscan de l’Antiquité Tardive au Moyen-Âge, scientifically 

directed by the Institut National d’Histoire de l’Art, and funded 

by Montalembert Foundation. The location is St. Honorat 

Island, the smallest island of Lérins archipelago, where two 

different chapels have been detected: the chapel of St. Michel 

and the Trinity chapel. 

In the case of St. Michel chapel, it proceeded to a complete 3D 

model of the foundations, which are still visible on the path next 

to the little harbor. The chapel is unpublished edifice; it is still 

waiting to be dated by future studies.  

 
Figure 3. Dense cloud, St. Michel Chapel. 

During the survey, the team had some difficulties because of the 

high movements of the trees by the strong blowing wind. Some 

rendering problems were met on the areas partially exposed to 

the sun. The total taken photos is 164 on both sides of the 

foundations, even on the dark side under the shadows, which is 

partially unreadable. The procedure is similar, as the equipment 

(lens Canon 18-55mm, focal length 30mm), is similar to the one 

used with the sarcophagus in Riva Ligure and completely 

automatic. The final treatment for mesh and texture was made 

with Meshlab (figure 3). As expected, the areas where the 

shadows were not static gave us a mesh with a big amount of 

noise. While, where the shadow was stable, the team has seen a 

high resolution level on the final texture.  

Finally, the photogrammetric process is a serial process; 

therefore, an error committed in one phase has repercussions on 

the followings phases. The photogrammetric work have to be 

performed by people, who proceed according to the theoretical 

or empirical rules, guaranteeing the metric rigor of the results. 

Any error of the principles of photogrammetry, from the 

acquirement of the images to the preparation of the orthofo 

mosaic, is fatal and negatively affects the successive phases of 

the work. Therefore, a careful planning phase and a verification 

phase are appropriate at the end of each work phase. 

 

3. DRONES AND PHOTOGRAMMETRY 

For almost a century the aerial photography was the only tool 

for medium and large extensions of territory cartographic 

production at a fairly high cost. Finally, starting from a few 

years ago and thanks to the drones of medium-low cost, it could 

easily produce accurate maps of different types with automated 

systems. The latest generation of drone sensors is able to obtain 

high-resolution images which, when combined in suitable 

fashion, produce accurate 3D models that prove to be precise 
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and suitable for measurement and stocked with a wealth of 

texture and detail. 

Another experiment of the team, on the site of Capo Don, is the 

realization of a photogrammetric model of the investigated areas 

using a Dji Phantom IV drone, thanks to the generous funding 

of the Marc de Montalembert Foundation. The surveyed area 

measures 40  30 m. The flight was programmed with the 

Pix4Dcapture application16, the overlapping followed with a 

scheme characterized by 80% of longitudinal strips, and 60% of 

cross-strips, all with nadiral shots; the altitude is 7 m above the 

suface level. GDS (Ground Sampling Distance) was 0.15 cm / 

px and the drone speed did not exceed 3 m / s. The maneuvers 

of the drone were great, although there was a strong wind. The 

duration of the flight did not exceed 10 minutes, 50% of the 

battery was used with all active functionalities. 

As for the GCPs points, we used the previous GCPs points used 

during the excavation campaign. Obviously this has 

compromised the accuracy of some areas without GCPs. The 

photos taken were about 40 frames. In this case, we used 

Agisoft Photoscan with an Educational License to see the 

differences with MicMac. The final product was of high quality, 

although it has been noticed that there is a lateral destruction of 

the orthophoto mosaic (figure 4). 

 
Figure  4. Mesh, the site of Capo Don ‘Costa Balenae’. 

The other drone survey is that on the site of Trinity chapel, in 

the St. Honorat Island to achieve all parts of the western facade 

with high precision. After a first attempt using the integrated 

GPS of drone that gave us bad results because of the lack of 

precision, we decided to align the wall through the manual 

rectification available in MicMac with the commands: 

SaisieMasq, SaisieBasc and SBGlobBascule. The 120 photos 

have been taken with a DJI Phantom IV and its photocamera 

(35mm equivalent), giving as result a very detailed orthophoto 

mosaic and DEM (figure 5).  

The last example to present in this meeting is a relief made by 

the drone for a part of the south facade and the two apses of the 

Trinity chapel. For the reconstruction of the building, the drone 

performed a semi-circular manual flight to take photograms 

with the drone’s camera inclined at 45 °. The height of the 

highest strip is 6 m, while the lowest one does not exceed 1.20 

m. Six-seven strips have been made at different levels, but the 

distance between drone and the structure was constant, 3 m, in 

such way that the focal distance remained the same in all 

images. Particular care has been taken to overlap horizontal 

images, which is 70-80%, while the lateral overlap is at least 

70%: this was necessary because in the case of automatic image 

processing, three homologous points belonging to the same 

object must be visible on 3 different images. 

 

 

                                                                 
16 To know more about Pix4D visit, its functions and its futures: 

https://www.pix4d.com/product/pix4dcapture/ 

 
Figure  5. DEM, Trinity Chapel. 

 
Figure  6. Drone’s strips system, Trinity Chapel. 

They shot about 194 images. The 3D model was developed with 

Agisoft Photoscan. The produced model was very good, despite 

the shadows of the surrounding trees, but thanks to the absence 

of the wind, such shadows did not influence the result (figure 

6). 

The first consideration, making use of our experiences with 

drone photogrammetry, is that all input data must be as constant 

as possible. In the case that the surveyed sites have strong 

altitude differences, the camera has to fly at the same altitude; 

otherwise, the GSD will vary greatly within the same model, 

decreasing its metric reliability. What is really important to 

maintain, is not the constancy of the flight altitude in 

comparison to the point of take-off, but the constancy of the 

altitude of flight from the object that must be surveyed. 

Therefore, it will be necessary to effect, many times, the flights 

piloting in manual; so it will be necessary to operate the flights, 

many times, flying manually. Therefore, it is better to avoid as 

much as possible the pre-programmed flights, because the 

drones flight-planning software does not precede that must be 

detected and the result which we want to achieve. Moreover, 

they do not always offer the possibility of varying the flight 

altitude along the route. 

The longitudinal strips must be increased to prevent the fact that 

the lateral destruction falls on the portion to be surveyed. 

Generally, it has been noticed that it is necessary to increase 

especially the crossed strips in the presence of objects in 

elevation, such as buildings. 

In the case of archaeological excavation sites, the ideal time to 

fly the drone is midday or at sunset to avoid the formation of the 

shadows that in some way compromise the photogrammetric 

model. In the case of a photogrammetric survey of buildings 

trapped between trees or other edifices, it is necessary to choose 

the time with the least amount of shadows as possible. The wind 

does not influence the drone’s camera, but it could play a fatal 
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role for the realization of the photogrammetric model in the case 

of tree shadow movements. 

The drones make it possible to acquire data for 

photogrammetric applications in a simple and economic way. 

Like most other geomatics techniques, drones and digital 

photogrammetry are not self-sufficient: integrations with other 

techniques are always necessary in order to make the process 

more and more complete, effective, and economical. 

The advantages of the drone are many: from the cost of 

purchase and maintenance, to the missions carried out 

autonomously, to the high maneuverability of the drone. The 

drone is the ideal tool for surveying in dangerous situations and 

in inaccessible areas. 

 

4. SPATIAL ANALYSIS THE LIMESTONE SYRIAN 

REGION CASE 

The Syrian Limestone area is a mountainous region, suited 

around 45 km north-western of Aleppo. It is composed from 

seven different mountains, narrow gorges, plateaus, very few 

water sources, and some small cultivable stains scattered 

everywhere in the territory. Two Roman roads also cross the 

territory: one of them was built during the Aurelian period, 

early of 2end century, while the existence of the second Roman 

road is attested within the works of Theodoret of Cyrus, bishop 

of Cyrus, before the first half of the 5th century. 

Since the 19th century, the archaeologists have recognized more 

than 800 archaeological sites concentrated in an area of 3 km2. 

It can be calculated around 266 m2 of free space usable for each 

single settlement. The restricted free areas are not only 

detectable outside the towns, but it is also a common feature 

inside the towns. Every settlement may contain from 10 to 109 

structures interpreted as houses. It also could hold two or three 

basilicas and one or two baptisteries attached to the churches. 

Other constructions are thermal baths, cisterns, oil mill, inns, 

etc. 

In 2010, in the occasion of my PhD, directed by Professor 

Philippe Pergola, research director in the French CNRS and 

professor at the Pontifical Institute of Christian Archaeology in 

Rome, a survey campaign was launched with a duration of three 

months which was financed by the kidnapped archbishop of the 

Syriac Orthodox Church of Aleppo: Mar Gregorios Yuhanna 

Ibrahim. It had to affront different concerns inherent to the most 

effective and innovative methodology to be followed during 

operations in the field, according to available funds, and around 

bureaucratic and territorial restrictions. The first problem was 

how to collect the territorial and archaeological data in an 

exhaustive way. To solve this problem, we opted for a Trimble 

R6 Model 4 GNSS Rover UHF 450-470MHz, with a 

centimeter-level accuracy, provided by the superintendents of 

Idleb. Unfortunately, to collect more geomatic data, even if the 

team was furnished by a drone, we couldn’t use it because of 

governmental limitations.  

To analyse the territory from point of view of geomorphology, 

we used some digital elevation models (DEM) from two 

combined sources. We utilized the first and second version of 

ASTER Global Digital Elevation Model, which, today, is one of 

the most important open source platforms on the market(17). I 

noticed that in version 2, the horizontal and vertical accuracy 

was increased as a horizontal resolution. This version is also 

distinguished by a reduced presence of artifacts and more 

realistic values over bodies of water. In 2015, two years before 

the end of reduction of my PhD, it also used STRM data 

(Shuttle Radar Topography Mission). It is highest-resolution 

                                                                 
(17) For more information about features,  and utilization of 

STRM data: https://asterweb.jpl.nasa.gov/gdem.asp 

topographic data generated from NASA's Shuttle Radar 

Topography18. Most voids are filled with elevation data from 

the ASTER GDEM2.  

All the steps of the present spatial analysis, could be performed 

in both the softwares of ArcGis and QGIS. At the conclusion of 

this paragraph, the reader will find a complete table of all the 

used commands in both software products. 

DEM data, before being used, should be prepared for utilization, 

because it often presents some empty cells without metric 

values (no-data pixel). Voids are often caused by water bodies, 

class type selection, or exclusion. Consequently, the first step 

before starting the spatial analysis is to fill these gaps by a 

specific process. The tool in both softwares uses the inverse 

distance weighting. It is generally not so great for interpolating 

a raster from sparse point data. Obviously, there are other more 

complex and less automatic ways to close voids, as for example: 

the Delta Surface Fill Method (DSF)19.  

The first real phase of the spatial analyses is to create a slope 

representation for the region. Slope represents the rate of change 

of elevation for each digital elevation model cell. It calculates 

the angle of inclination to the horizontal. It’s the first derivative 

of a DEM. The other file to create is the aspect of the terrain 

data, which also derives from a raster surface. The aspect 

identifies the downslope direction of the maximum rate of 

change in value from each cell to its neighbors. It is useful to 

calculate the solar illumination for each location in a region as 

part of a study to determine the diversity of life at each site, to 

find facing slopes, and to identify flat areas appropriate for the 

installation of settlements or agriculture (figure 7).  

 

Figure  7. Aspect layer, Syrian Limestone Region. 

Overlaying the Slope and Hillshade results, with a 33% 

transparency, and combining them with the monastic 

settlements’ GPS points, it was possible to highlight a lot of 

unpublished information. The geostatistical information 

confirms that the main part of the monasteries of the region are 

built on the top of the hills or on their slopes, while the 

monasteries built on the plateau areas are so limited (figure 8).  

More than 43% of the monasteries are installed on the tops of 

the hills, 27% of the analyzed monasteries are located on the 

slopes of the hills, and 11% are located in the valley bottoms 

and plateaus. The remaining 11% of monasteries are still 

waiting to be more investigated. 

 

                                                                 
18 For more information about features,  and utilization of 

STRM data: https://www2.jpl.nasa.gov/srtm/ 
19 Burrough, McDonell, 1998. 

The International Archives of the Photogrammetry, Remote Sensing and Spatial Information Sciences, Volume XLII-2/W11, 2019 
GEORES 2019 – 2nd International Conference of Geomatics and Restoration, 8–10 May 2019, Milan, Italy

This contribution has been peer-reviewed. 
https://doi.org/10.5194/isprs-archives-XLII-2-W11-601-2019 | © Authors 2019. CC BY 4.0 License.

 
605

https://asterweb.jpl.nasa.gov/gdem.asp
https://www2.jpl.nasa.gov/srtm/


 

 

 

Figure  8. Geomorphological positions of the monasteries. 

After extrapolating the contour layer from the DEM with the 

appropriate command, we have proceeded to the analysis of the 

altitudes on which these monasteries had been erected. The 

mathematical results are listed in table 1. 

 

Type Altitude in  

Medium  467 m.a.s.l. 

Standard Deviations 658 m.a.s.l. 

Minimum 327 m.a.s.l. 

Maximum 588 m.a.s.l. 

Table 1. Altitude of monasteries. 

The spatial analysis relating to the distances between 

monasteries and villages, using Near tool in ArcGis or Distance 

Matrix in QGIS, has been confirmed: 84% of the total 

monasteries are located not more than 2 km from the nearest 

town, while more than 53% of the monasteries are installed 

within 1 km from the nearest settlement20. The mathematical 

results are listed in table 2. The explanation of the curious 

proximity between the monasteries and the agglomerations 

could be due to possible economic and religious-social relations 

between the monastic centers and the inhabited centers. 

 

Type Distance in km  

Medium  0.92 

Standard Deviations 0.65 

Minimum 0.03 

Maximum 2.21 

Table 2. Distance between monasteries and villages. 

Within the topographical research project, such as the limestone 

region, where there is a dense quantity of archaeological sites, 

the analysis of visibility is particularly important in order to 

know the visibility of monastic settlements with respect to the 

surrounding landscape and the secular settlements (Figure 9). 

The visibility analysis is carried out by locating a set of possible 

points of view on the cartographic base and simulating the 

views from these points. This technique is a generalized 

analysis, based on the relations of the entire surrounding 

territory and the examined archaeological sites, in order to 

provide objective elements for the evaluation of the territory 

and its structures.  

                                                                 
20 E. Kas Hanna 2018, 5-80. 

 

Figure  9. Visibility, example of the sites Dar Qita and Ma‘ez. 

The geo-morphological observation has brought to light further 

data, which is very essential to understand the monastic 

topography in this part of Syria. Not only the monasteries are 

installed next to the secular villages and main Roman roads, but 

also they are also located in the highest points of the territory 

around the settlements in such way as to be visible to the 

population. The statistic indicates that 91% of the monasteries 

are visible at least from one or more settlements.   

 

Figure  10 – Percentage of the monasteries from the settlements. 

The following table (table 3) shows all the used commands for 

the spatial analysis of the Syrian region within both software 

products: 
Application ArcGis QGIS 

Fill DEM Windows -> Add Function -

> Identify Function -> Insert 

Function -> Elevation Void 

Fill Function 

Raster -> Analysis ->  

Fill nodata 

Slope Arc Toolbox -> Spatial 
analysis tool -> Surface -> 

Slope 

Raster -> Analysis ->  

Slope 

Aspect Arc Toolbox -> Spatial 

analysis tool -> Surface -> 

Aspect 

Raster -> Analysis -> 

Aspect 

Contour Arc Toolbox -> Spatial 
analysis tool -> Surface -> 

Contour 

Raster -> Extraction ->  

Contour 

Visibility Arc Toolbox -> Spatial 
analysis tool -> Surface -> 

Viewshade 

And Arc Toolbox -> Spatial 
analysis tool -> Surface -> 

Observer Points 
 

Raster -> Viewshed 
Analysis ->  Viewshed 

Analysis 

Proximity Arc Toolbox -> Analysis 
Tools -> Proximity ->Near 

Menu -> Analysis 
Tools -> Distance 

Matrix 

Table 3. Commands in ArcGis and QGIS. 
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5. GEOMATICS APPLICATION ENVIRONMENTS: 

EXAMPLES 

In the last years, geomatics has stimulated and continues to 

inspire the evolution of more advanced technologies: newer, 

faster, smaller, and more accurate instruments capable of 

providing complete three-dimensional data. On the other hand, 

procedural evolution makes possible the quick and especially 

automatic extract of the requisite information while innovation 

in spatial storage techniques (GIS) allows us to propose 

numerous final products that are easier to read and use for 

effectively facing the planning processes in the area of 

protection and valorization of cultural heritage. The potential 

ways to use Geomatics are limitless as the technological frontier 

continues to move forward. Digital supports are always cheap 

and easy for technical, educational, or recreational purposes. 

Assessing the archaeological sites is an activity aimed to 

promote and to understand the values expressed by cultural 

heritage while investing, mainly, the profits deriving from the 

protection. It is ideal for cultural heritage, for documentation, 

and for 3D modelling of archaeological sites from high-

resolution images. Geomatics has a role of service aimed to the 

mere acquisition of metric data to better interface with other 

disciplines that apply to the study and preservation of heritage. 

The 3D surveys could be used for the investigations and the 

restoration projects of the archaeological buildings. The 3D 

survey technologies are useful to monitor the process of 

physical and structural deformation and degradation of the 

archaeological monuments. So, geomatics could be essential to 

planning in a conscious way, and at the most opportune 

moment, any requisite interventions on things that are subject to 

risk of destruction in some way. Geomatics techniques must in 

the future contribute effectively to the implementation of 

specific databases related to the mapping of Cultural Heritage 

under a risk21. 

The heritage resources of Syria, unfortunately, are largely 

unknown. This is a natural consequence of the lack of a 

comprehensive record of sites, monuments, and significant 

finds. This makes heritage assets vulnerable to loss or change 

through conflicting land use and unsympathetic development. 

Many archaeological monuments in Syria have been lost 

forever, such as the triumphal arch, several temples of Palmira, 

and the baths and the markets of the medieval city of Aleppo. 

The sites of the Syrian Limestone region have suffered many 

irreparable damages: certain sites have been erased with 

mechanical means or heavy missiles, such as the case of the 

Esh-Sheikh Barakat temple (figure 11). 

 

Figure  11. Esh-Sheikh Barakat temple 2004 - 2014. 

 

Fortunately, for the temples and the triumphal arch of Palmyra 

there are 3d reconstructions, faithful to the originals, made with 

the laser scanner and lidar, but unfortunately, it can’t be said for 

                                                                 
21 Brumana, Monti 2004. 

the destroyed sites of the Limestone region. Therefore, in the 

future the building of a National Heritage Inventory will need to 

be placed at the very top of the agenda quite simply to enable 

the Department to accomplish its role in Law. 

One of the methods of application of geomatics, used by our 

research group, has been in the field of the divulgation of the 

archaeological heritage on the public level. In 2017, due to the 

positive geomathic results during the last seasons of our 

excavations on the site of Capo Don, the first Multimedial 

Exhibition Space (SEM) of the town Riva Ligure was 

inaugurated thanks to Comune of Riva Ligure, Nino Lamboglia 

Foundation, and all research team members guided by professor 

Philippe Pergola. SEM is an interactive museum where all the 

most important findings of the Capo Don site are present, like a 

tombstone of Mary and its Latin inscription (figure 12). 

 

 

Figure  12. SEM, comune of Riva Ligure (IM). Photo by 

Alessandro Bonaldo 

After the opening day of this museum, the level of interest in 

the population for the Capo Don site has progressively grown. 

For the next five months after the launch day, SEM received 

about 4000 visitors, and tourists from all ages and of different 

interests. Consequently, the interactivity of the museum has 

pushed the people to visit the site in reality that is located about 

1.5 km outside of the village. 

Another important role that geomatics may play is in the 

pedagogical field: printing the photogrammetric models of 

buildings, objects, and other staffs for pedagogical purposes, 

both for specialists, and for people of all the interests, and all 

ages. It is true that these printers are currently very expensive; 

however, thanks to the technological advancement of these 3D 

printers, they will soon be easily accessible. 
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The geomatics documentation of movable and immovable 

goods is suitable also to study purposes, thanks to the fact that 

their products are nowadays digital which allows a metric and 

also a qualitative description that can make use of different 

survey tools that can be interfaced with each other. 

It is now clear that we are today in the Digital era, geomatics 

should use it on a larger scale especially for the conservation of 

cultural heritage, because it is able to offer a wide range of 

instruments and methodologies, characterized by a high degree 

of innovation and technology. Looking critically toward this 

vast panorama, it is possible to use geomatics more effectively, 

like a ‘virtual archaeology’, to create new technologies for 

reason of safeguarding the historical and artistic heritages.  
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